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1.0 Introduction

Based upon a review by the Feasibility Analysis Team (FAT), an NSSC Study Team was tasked with
evaluating the feasibility of transitioning Invoice Escalation back to the NSSC. The NSSC Study
Team recommended the action to the Executive Round Table (ERT) and the transition, Decision
Memorandum 2018-002, was approved by the ERT on April 24, 2018. Therefore, the NSSC will
escalate invoices for all NASA Centers effective July 1, 2019.

Invoices are received by NSSC Accounts Payable (AP) via two methods:

¢ Invoices from the Invoice Processing Platform (IPP) are automatically parked in SAP

e Non-IPP invoices are received at NSSC Document Imaging (Dl) via hardcopy (paper),
email, or fax. Those invoices are routed through the Accounts Payable Work Management
System (AWMS) queue and manually parked in SAP by the Vendor Payment Processor
(VPP).

Invoices are reviewed for accuracy by the NSSC VPP and either rejected as improper or routed in the
Invoice Routing and Information System (IRIS) for required actions (Cost, Funding, Goods Receipt
(GRAP) and Approval) within 72 hours (3 business days) of receipt. IPP invoices meeting certain
criteria auto-route for Cost and/or Approvals.

e Centers will continue to monitor their cost and Funding IRIS queues and assign the IRIS tasks
as needed. This will allow the NSSC to escalate to the individuals that are assigned Funding
IRIS tasks. Centers will ensure the POCs have the applicable NAMS role, so they can be
assigned those tasks.

o NOTE - the Cost Process Champion Team POCs will monitor and escalate any Cost
IRIS actions.

e Centers will continue to monitor their IRIS FI Approval queue and assign IRIS FI Approval
tasks to the transportation POCs as applicable (FedEx invoices, etc.). Centers will ensure
transportation POCs have the applicable NAMS role setup in the FI Approval queues, so they
can be assigned those tasks.

o LONG TERM SOLUTION Centers will have awards and obligations in place for shipping
charges. This includes utilization of the government wide agency contract for UPS and
FedEx

e NSSC VPP Leads have the applicable NAMS role setup in each center FI Funding queue so
the VPPs can self-assign Interest FI Funding tasks.

e NSSC Invoice Escalator (IE) POCs have the applicable NAMS role setup in each Center
GRAP queue so the |IEs can self-assign GRAP tasks.
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e For contractor escalations, the NSSC will attempt to identify the contractor's org and look up
the CS Chief of that organization to perform escalation. If contractor’s org is not available in
the global email directory, the CS Chief will not be included in the Supervisor escalation.

e The NSSC plans to utilize existing HR org charts to conduct escalation. Link:
https://orgpub.nssc.nasa.qov/OPSilverlight/PF_ NASA/UI/PE_NASA.htm. Centers are
responsible for completing their assigned IRIS requests timely and clicking the “Complete” or
“‘Reject” button in IRIS to indicate completed actions.

o NOTE: NSSC VPP Leads will self-assign Interest FI Funding requests
o NOTE: NSSC IE will self-assign GRAP requests and complete IRIS actions once the
103/105 has been completed

Note 1: Escalation starts from the Adjusted Prompt Pay Due Date.

Note 2: This Escalation Process does not include final invoices handled through the Closeout
Process, Credit Memo’s, Supplemental Documentation (SD) or SBIR/STTR’s.

Note 3: For the Agency to avoid manual processing and achieve system efficiencies, the Agency
Applications Office (AAO) implemented auto routing for IPP invoices and will consider enhancements
to IRIS for the Escalation Process that have been submitted by the Procure to Pay Process
Champion.

2.0 Purpose

To outline Agency procedures followed by the NSSC related to escalating invoice actions to ensure
timely vendor payments.

3.0 Applicability/Scope

The NSSC is responsible for providing invoice escalation to help ensure timely vendor payments
and avoid interest payments. The NSSC shall process all documents in accordance with the Prompt
Payment Act. The NSSC shall process payables from receipt of the initial invoice to payment.

The NSSC shall use the Agency’s Core Financial Software, Systems, Applications and Products
(SAP), the Invoice Routing and Information System (IRIS) and ServiceNow to perform financial
management activities. The NSSC is required to adhere to NASA Procedural Requirements (NPR),
NASA’s Enterprise Performance Support System (EPSS), and other applicable Federal regulations
and NASA policies and procedures.

4.0 Privacy Data

All participants involved must ensure protection of all data covered by the Privacy Act.

5.0 Records
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Records shall be maintained in accordance with NPR 9615, NASA Records Retention Schedules.
These records are included in the Financial Management Division (FMD) functional Master Records
Index (MRI), applicable NASA Records Retention Schedule (NRRS) or General Records Schedule
(GRS) items that provide retention/disposition authority.

6.0 Cancellation/Supersession of Previous Documents
This version supersedes version 3.0 of the same document.

NOTE: The Service Provider (SP) is responsible for documenting and maintaining all macros/scripts
utilized in these processes.
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PROCESS 1 - EXECUTE SAP AND IRIS REPORTS TO IDENTIFY AGING
INVOICES

STEP 1. NSSC Service Provider (SP) Accounts Payable IE obtains daily Escalation Reports

A. Each business day, BOT Adams Logs into SAP at 4:00 am and executes t-code

ZFI_AP_INVC_STAT

1. Manual Process - Access SAP

In the Menu search field, enter t-code ZFI_AP_INVC_STAT
Click green check mark
Select “Open Items as of” Defaults to current date
Select Parked
Select Posted
Under Document Type, click right arrow

1. Select Exclude Single Values

2. EnterZl, ZC, ZH, ZL
g. Click Execute (clock icon)
h. Once Executed, select “Change Layout

1. Add:
a. Fiscal Year
b. Outline Agreement

c. PPS Contract Number
d. Purchasing Document
e
f.
g

~0® Q000D

”

. Legacy Agreement
Reference
. Text
h. Posting Date
i. Export to Excel
j- Save to file location per FY and month: N:\FM Division\Accounts
Payable Accounts Receivable\Accounts Payable\Escalation (SAP AP Invc
Stat Report MM DD YYYY)
k. End

B. Each business day, BOT Adams Logs into IRIS at 4:00 am and executes the IRIS
Escalation Report

1. Manual Process - Access IRIS via web; https://iris.nasa.qov
Select Reports
Select Escalation
Select Export
Save to file location per FY and month: N:\FM Division\Accounts
Payable _Accounts Receivable\Accounts Payable\Escalation (IRIS
Escalation Report MM DD YYYY)
1. Delete the following columns:
2. Cost Pending

cooo
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3.
4.
5.

GRA Pending
Funding Pending
Approval Pending

e. Add the following columns:

f. Re

>ohwN

t

C

Wh =

4.

5.

Cost Assign To next to Cost Pending
GRA Assign To next to GRA Pending
FI Funding Assign To next to Funding Pending
Contract Funding Assign To after FI Funding Assign To
Int. Funding Assign To after Contract Funding Assign To
FI Approver after Int. Funding Assign To
rn to IRIS: https://iris.nasa.gov
Select “Pending Requests”
Select “Cost”
From the Cost queue, identify the DRN and the associated
“Assigned To” person under the Assigned To field.
Lookup the DRN on the IRIS report and populate the Assign To
name under the “Cost Assign To” column.
If the associated “Assigned To” person is blank, populate the word
“‘UNASSIGNED” under the “Cost Assign To” column.

g. Return to IRIS: https://iris.nasa.gov

1.
2.
3.

4.

5.

Select “Pending Requests”

Select “Good Receipt”

From the Good Receipt queue, identify the DRN and the
associated “Assigned To” person under the Assigned To field.
Lookup the DRN on the IRIS report and populate the Assign To
name under the “GRA To” column.

If the associated “Assigned To” person is blank, populate the word
“UNASSIGNED” under the “GRA To” column.

h. Return to IRIS: https://iris.nasa.gov

o=

o

7.

Select “Pending Requests”

Select “Funding”

From the Funding queue, identify the Req Type.

For Request Type “Funding” and the DRN starts with 19 or
Capture the DRN and the associated “Assigned To” person under
the Assigned To field.

Lookup the DRN on the IRIS report and populate the Assign To
name under the “FI Funding Assign To” column.

If the associated “Assigned To” person is blank, populate the word
“‘“UNASSIGNED” under the “FI Funding Assign To” column.

i. Return to IRIS: https://iris.nasa.qgov

1.
2.
3.

Select “Pending Requests”
Select “Funding”
From the Funding queue, identify the Req Type.
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4. For Request Type “Funding” and the DRN starts with 56 and either
or both of the Outline Agreement or Task Order/PO fields are
populated,

5. Capture the DRN and the associated “Assigned To” person under
the Assigned To field.

6. Lookup the DRN on the IRIS report and populate the Assign To
name under the “Contract Funding Assign To” column.

7. If the associated “Assigned To” person is blank, populate the word
“‘“UNASSIGNED” under the “Contract Funding Assign To” column.

j-  Return to IRIS: https://iris.nasa.gov

Select “Pending Requests”

Select “Funding”

From the Funding queue, identify the Req Type.

For Request Type “Funding (Int)”

Capture the DRN and the associated “Assigned To” person under
the Assigned To field.

Lookup the DRN on the IRIS report and populate the Assign To
name under the “Int. Funding Assign To” column.

7. If the associated “Assigned To” person is blank, populate the word
“‘UNASSIGNED” under the “Int. Funding Assign To” column.

k. Return to IRIS: https://iris.nasa.gov

1. Select “Pending Requests”

2. Select “Approval (FI)”

3. From the Approval (FI) queue, identify the DRN and the
associated “Assigned To” person under the Assigned To field.

4. Lookup the DRN on the IRIS report and populate the Assign To
name under the “FI Approver” column.

5. If the name is populated in the Approver Name field, delete the
name in the Approver Name filed.

6. If the associated “Assigned To” person is blank, populate the word
“‘UNASSIGNED” under the “FI Approver” column.

A

o

. End

C. BOT Adams logs into ServiceNow at 4:30 am and automatically loads the IRIS and SAP
reports.

1. The IE may load reports manually:
a. To load the IRIS report, log into ServiceNow via the NSSC internal web
(https://internal.nssc.nasa.gov/)
Select ServiceNow
In the Filter Navigation field, enter Invoice Escalation
Select Load Data
Select IRIS Report
Click on paper clip

"0 Q0T
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g.

h.

Navigate to: N:\FM Division\Accounts Payable Accounts
Receivable\Accounts Payable\Escalation (IRIS Escalation Report MM DD
YYYY)

Select today’s IRIS report

Click Open

2. To load the SAP report, log into ServiceNow via the NSSC internal web
(https://internal.nssc.nasa.gov/)

a.
b. In the Filter Navigation field, enter Invoice Escalation
c. Select Load Data

d.
e
f.

g.
h.

Select ServiceNow

Select SAP Report

. Click on paper clip

Navigate to: N:\FM Division\Accounts Payable_Accounts
Receivable\Accounts Payable\Escalation (IRIS Escalation Report MM DD
YYYY)

Select today’s SAP report

Click Open

STEP 2. Email Daily Agency Reports to center POC’s

Note: Reports are scheduled to automatically email at 9am daily or on specific days each
week. Daily Agency Reports will be sent to each business area POC per Escalation Type
(Approval, Contract/PO Funding, Cost, FI Approval, FI Funding, GRA Pending, and Interest

FI Funding).

Note: If the IRIS and SAP report upload fails and the issue is not resolved by 9:00am, the IE
Team will send an email to the recipients of the reports advising them that the reports will

not be distributed.

Note: The Interest FI Funding Report will be emailed to the NSSC VPP Leads.

Note: Reports exclude (Text Field = CR -Credit Memo’s, Finals, SBIR/STTR, SD)
Invoices identified as:
o 8 days or less before adjusted prompt pay due date will be highlighted in red
o 9-15 days before adjusted prompt pay due date will be highlighted in yellow

A. Daily Agency Reports — Perform for each NASA Center
B. Create Daily Agency Reports

LD

Log into ServiceNow via NSSC internal web (https://internal.nssc.nasa.gov/)
Select ServiceNow

In the Filter Navigation field, enter Invoice Escalation

Select Daily Agency Reports

Within Daily Agency Reports, select a report
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6. If the report is for a specific center, include the initials of the center at the end of
the name of the report:
ie: Daily Agency FI Approval Report - SSC
7. If report includes grouping data, click the field “Group by” and select the desired
column
8. “Columns” field allows selections to add/remove column data fields
9. Review the current condition and add/remove any condition(s)
10. If condition is for a specific center, add to the condition:
a. And
b. Select Center for the field
c. Select “is” for the next field
d. Select the magnifying glass
e. Enter the center abbreviation
f. Select the correct center
ie: for NSSC, enter NASA in the Name field and NSSC in the center abbrv
field
g. Once criteria is met, select RUN found in the top right blue button
h. Scroll to bottom and right click on any column header
i. Exportin the desired format (export, PDF, Landscape)
Review data to ensure the report is generating all desired information
Once report is correct, select the down arrow next to the blue RUN button
j- Select Save

C. Schedule Daily Agency Report

1. In Filter Navigation display, type view / run

2. Select View / Run under reports
a. A list of your created report(s) are available
b. Select the desired report for scheduling
c. Select the down arrow next to the blue run bottom top right corner
d. Select Schedule
e. Inthe “name” field, name the scheduled report and end with the report

format

MName Scheduled Execution of Daily Agency Fl Ap

i.e.: Scheduled Execution of Daily Agency FI Report - PDF
f. In the report field, copy the name of the created report

Report Daily Agency Fl Approval Report-AR =~ Q

i.e.: Daily Agency FI Report
g. Paste the report name in the Subject field

Subject Daily Agency Fl Approval Report - ARC
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h.

n.

O.
p.
qg.

Click the padlock on Users

Users @ || £

If email is not known, select the magnifying glass for the lookup user list

O

b

&=

Enter the first name in the first name field
Enter the last name in the last name field

= First name = Last name

Verify the names of the output. Note: Names should be
verified in Global Outlook Address List

. Select the correct name

= Name A = First name = Last name = UserID = Email = Business phon
sarita harper

Sarita Harper  Sarita Harper

SARITA SARITA HARPER srharpel sarita.harper@nasa.gov 228.813.6913

HARPER

Sarita Harper ~ Sarita Harper

sarita harper  sarita harper

Sarita Harper ~ Sarita Harper

The name will appear as a User
SARITAHARPER

Type the email in the “enter email address” field if known
Enter
The name will appear as a User

3. Schedule Reports

a.
b.
c.

Run field dropdown provides various options for scheduling time

Time field allows the hour and minute the report is to be scheduled

If the report is only to be scheduled when data appears, select the “Omit if no
records” field
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d. To identify specific days for the report to be distributed, select Conditional

Active v
Run Daily hd
Time Hours |09 00 00
Conditional v
Omit if no records v

e. Copy and paste code below beginning with //Days and ending with
Weekdays();

/I Days of the week are Monday 1, Tuesday 2, Wednesday 3, Thursday 4,
Friday 5

function check Weekdays() {
var now = new GlideDateTime();
var day = now.getDayOfWeek();
var result = false;

if(day == 2 || day == 4) {

result = true;
}
return result;
}
checkWeekdays();

The code listed above is showing how to run the Scheduled report on Tuesday and
Thursday. To run the report more or less days, change the “if’ line to reflect the
day(s) based on the number reflected in the first line.
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If the report is to be distributed 5 days a week, code will be set as:

// Days of the week are Monday 1, Tuesday 2, Wednesday 3, Thursday 4, Friday 5
function checkWeekdays() {

)
checkWeekdays();

var now = new GlideDateTime();

var day = now.getDayOflheek();

var result = false;

if(day == 1 || day == 2 || day == 3 || day == 4 || day == 5) {
result = true;

}

return result;

4. Appendix D through L provides assorted templates to be pasted into the body of
the Introductory Message for the various types of reports
a. Once template has been pasted, a popup will allow you to keep formatting
b. View the message
5. Type of report format
a. Dropdown allows various pdf or excel format of the report
6. Once completed, select submit
7. If additional format of the report needs to be included on the original scheduled
report, see how to link excel report to pdf report in Step D

D. Link excel report to pdf report

1.

In the Filter Navigation, type Scheduled Reports

l: Y Scheduled Reports

*

2. Select Scheduled Reports under report header

Reports

Scheduled Reports

a. In the Name field, type Scheduled Execution of Daily Agency

= Name

Scheduled Execution of

3. Press Enter



NSSC

Service Delivery Guide

NSSDG-9200-0012 Revision 4.0

Number

Effective Date: May 14, 2021
Expiration Date: May 14, 2024

Page 18 of 69

Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

4. At the bottom of the report select the blue NEW button next to included in Email

= Included in Email m

5. In the name field, paste the name and add the format afterwards

e.

ie: Scheduled Execution of Daily Agency FI Report — Excel

a. Run field dropdown and select “On Demand”
b.

Select the box next to “Omit if no records”

Run On Demand hd
Conditional
Omit if no records v

Scroll below the introductory message and using the dropdown for type,
select the format

Make sure the field “Include with” identifies the original Scheduled report
name

Include with Scheduled Execution of Daily Agency Fl Approval Report - ARC - Thursday

Click Save

E. Allow Groups and Users to make changes to reports

1. Log into ServiceNow via NSSC internal web (https://internal.nssc.nasa.gov/)
2. In Filter navigator field enter View / Run

3. Select View / Run

4. In the Search field, enter the name of the report to unpublish

: Daily Agency Cost

5. Under Title select the report
6. Use dropdown option between Switch to new Ul and Run

Switch to new Ul Save =
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7. Select Sharintl;
Switch to new Ul Save E‘ .

Update

BA | Insert
Center
Doc Numbs
Reference.
4 | |Reference.t Schedule
Reference.d  u44 15 pashhoard ber
Invoice Am
Invoice Reg

Insert and Stay

Delete

Sharing
Export settings

Export to PDF
Mi

8. Sharin Settin s, select Groups and Users and the group name to allow changes
Sharing settings

Visible to: Me ® Groups and Users
Groups Users
FM - ACCOUNTS PAYABLE | .
FM - ACCOUNTS PAYABLE 9% ]
& ®
)
Select group Select user

Close

9. Select Close
10. Select Save

CanolPenton * O, [

Daily Agency Approval Report - JSC @ Switchtonewll | Save | = l

Avalzble Selected
Center [+] . BA
Active Center
Activity due Doc Number

Data | Table w | IRISEscalations [x_nasl0_ap_invoice u_.. ¥

Type | List v @

F. Change report frequency condition

1. Log into SNOW, type in the navigation filter:
Service Catalog
NSSC Services
IT-Applications/Systems
Application Support

Service Catalog = N5SSC Services = IT - Applications/Systems = Application Support

o oo
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2. Low-Impact Data Change Request Form — complete

Department

Priority

Application

Assign To

Specific record ID or criteria for which records should be affected — enter a
brief statement

P20 TO

E] Low-Impact Data Change Request Form

Department

M w
Priority

1-Critical v
Application

ServiceNow ¥
Assign To

ServiceNow Developers v

Specific record ID or criteria for which records should be affected:

‘ Scheduled Reports: Scheduled Execution of Daily Agency Cost Reports

f. DATA — Enter brief statements

B Data

Current data to be replaced:

/| Days of the week are Monday 1, Tuesday 2, Wednesday 3, Thursday 4, Friday 5
function gheckWeskdays) {
yagnow=new GlideDateTims(;
varday=now.getDay0fWieek();
yarresult=false;
iflday = 1| day==4){
result=true;
i
return result;
}
CheckWeekdays();

New data to be used as replacement:

|/ Days of the week are Monday 1, Tuesday 2, Wednesday 3, Thursday 4, Friday 5
function gheckWeekdays() {
varnow=new GlideDateTime();
var day = now.getDay0fWeek();
varresult=false;
iflday==1||day=2| day=3 day=4|| day=5){
result=trug;

]

return result;

I
checkWeekdays();
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g. Validation — Enter a brief statement

(<] validation

Method for validating the change:

Frequency to be business days, Monday through Friday

G. Pause Scheduled Report(s) Distribution
1. Log into ServiceNow via NSSC internal web (https://internal.nssc.nasa.qgov/)
2. In Filter navigator field enter Scheduled Reports
3. Select Scheduled Reports

? scheduled

Reports

Scheduled Reports

o3
4. Update Personalized list by selecting the Gear Icon
5. Add the following columns: Report and Active
Available Selected
Customer update (Mo Longer | Active
Display name g Name
Email addresses Report
6. Scroll Active field to the top of the list )
7. Click OK

8. In name search field type the Scheduled Report name. Note: If the exact name of
the report is not known, begin with below example and all Daily Agency Reports will
populate

= Name

‘ Scheduled Execution of

ie: Scheduled Execution of Daily Agency
9. Select List controls located on the left of scheduled email of reports at the top left

of screen selecting the hamburger icon
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10. Select Show
11. Select amount of documents to be viewed at one time

=  Crhadulad Email of Reports Ge
View > L
T . ) :
Filters > With Scheduled Execution
. Group By >
535 E.. L Y B, :
shon [ orowperese |
Refresh List 25 rows per page [
Create Favorite 50 rows per page |

100 rows per page
(D true V500 rowsperpage |

T LIranE

12. Double click first item under active column

= Active

true

13. Change true to false by using dropdown and select checkmark once completed

(m)© ®
——

true .
- Fl Funding

Report -
NMO - EXCEL
14. With cursor in first field of active column, hold down shift key and use down arrow
scrolling down to include all reports
15. After all the fields of the active column are selected with a light blue color, double

click in the last item, use dropdown, change desired active field from true to false,
click checkmark. All highlighted reports will change to false.

H. Activating Scheduled Reports
1. Log into ServiceNow via NSSC internal web (https://internal.nssc.nasa.gov/)
2. Select ServiceNow
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3. In the Filter Navigation field, enter Scheduled Reports

? scheduled

Reports

Scheduled Reports

235

4. Update Personalized List by selecting the Gear icon
5. Add the following columns: Report and Active
Available Selected
Customer update (Mo Longer | Active
Display name ~ Name
Email addresses Report

6. Scroll A‘:ctive field to the top

7. In name search field type the Scheduled Report name. Note: If the exact name of
the report is not known, begin with below example and all Daily Agency Reports will
populate

= Name

‘ Scheduled Execution of

i.e.: Scheduled Execution of Daily Agency

8. Select List controls located on the left of scheduled email of reports at the top left

of screen selecting the hamburger icon
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9. Select Show
10. Select amount of documents to be viewed at one time

=  Crhadulad Email of Reports Ge
View > L
T . ) :
Filters > With Scheduled Execution
. Group By >
535 E.. L Y B, :
shon [ orowperese |
Refresh List 25 rows per page [
Create Favorite 50 rows per page |

100 rows per page

(D true V500 rowsperpage |

T LIranE

11. Double click first item under active column
12. Change false to true by using dropdown and select checkmark once completed

(=)0,
o f

true o
- Fl Funding

Report -
NMO - EXCEL

13. With cursor in first field of active column, hold down shift key and use down arrow
scrolling down to include all reports

14. After all the fields of the active column are selected with a light blue color, double
click in the last item, use dropdown, change desired active field from false to true,
click checkmark. All highlighted reports will change to true.

|.  Adding Columns to Existing Reports
1. Loginto SNOW
2. Type View in Navigation Filter

Favorites

Reports - View / Run

Reports

View / Run
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3. Select View / Run under Reports
Reports

View / Run

Select All tab

s

= Reports My reports = Group = Global | All

5. In the Search bar (top right side) type Daily Agency; then press

Title contains: Daily Agency | a

Enter

6. If you want to specify a specific report type the full name:
i.e.: Daily Agency Approval Report

7. All reports with that naming scheme will appear including all centers. It is best
practice to pull this way and not specify the name of the center because if there is a
space after report, hyphen, space and center name you could possibly miss it if you
fail to include the spaces in the correct areas.

8. Click into the report under title

4 Title

Daily Agency Cost Report

Scroll down Available selection until you reach Reference. Notice Reference is
in green and has a plus sign next to it. Highlight Reference

Available

| Reference [+]

9. Once reference is highlighted above the up/down arrows a plus sign appears
10. Select the plus sign above the up/down arrows

Available

Reference [+]
SAP Invoice Text ~ 7

SLA due -
11. Once the plus sign is selected, another set of options are available
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12. The Reference information we need is from SAP Invoice Stat Report. Notice IRIS
Record and SAP Record have plus signs

Available
Created by
Doc Number

IRIS Record [+]
SAP Record [+]

13. Since;he additional columns are from the SAP Invoice Stat Report, select SAP
Record

14. From the available listing scroll until you see the name of the column to be added
to the Selection. The name of the columns to add are: Vendor Name, Invoice
Number, OA/Contract

Available Selected
IRIS Escalations fields BA
Reference--=Invoice Escalation F#N Center A
.SAP Record—-=SAP Invoice Stat f Doc Number
533Ind L4 Reference.SAP Record.Vendor Na -~
Columns | Active 4 Reference.SAP Record.Invoice Nu -
Adjusted Prompt Pay Due Date Reference.SAP Record.OA/Contrz
Amount V] Invoice Amount W
Approval Invoice Received Date

15. When the additional column is added to the selected field, highlight the column
name and arrow up until the column titles are as below.

b BA Center Documber VendorName InvoiceNumber  OAContractNumber  InvoiceAmount  Invoice Received Date  Adjusted Prompt Pay Due Date A PO Number

16. Once the column names are in order, Select Run in the top right corner

Switch to new Ul Save | = “

17. Review the report, export for viewing to ensure everything is visible
18. Select Save next to run in the top right corner
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PROCESS 2 — DAILY ESCALATION PROCESS

STEP 1.

>

moow

@m

ServiceNow Escalation

Each day, the IE logs into ServiceNow via NSSC internal web
(https://internal.nssc.nasa.gov/)

Select ServiceNow

In the Filter Navigation field, enter Invoice Escalation

Select IRIS Approvers Overview

Within Interactive Analysis, select Business Area (BA) with escalation activity (BA is not

zero)

Click on drop down arrow next to BA
Select Information lIcon next to Approver Name to open escalation tabs
1. Email Tab: Escalation actions are only required if a document number is present
on the tab.
Note: Comments under this section apply to the sections below).

a)
b)

If the email tab lists activity, select envelope icon next to Email

Navigate to Outlook to identify the Assign To email address and populate the

Escalation email

Click Send

Make notes in the task and record work log

Copy notes to IRIS

In SNOW under IRIS Escalation Tasks section, check box next to the

task/document number

Drop down and select Close Selected

Access ServiceNow history and attach email, notes and center responses

received via calls and emails, to each document in IRIS
Note: Each business day, BOT G. Washington logs into Microsoft Outlook
nssc-ap-invcescalation@mail.nasa.gov Archive folder at 7:00pm and
attaches all correspondences to each document in IRIS

2. Phone Call Tab: Escalation actions are only required if a document number is
present on the tab.

a)

b)
c)

d)

If the Phone Call tab lists activity, IE calls the Assign To person to discuss list
of aging documents using the Phone call template listed in the Appendix
section

|IE adds notes in the Work Notes section

IE will send a follow-up email to the Assign To person and his/her supervisor
using existing HR organization charts
(https://orgpub.nssc.nasa.gov/OPSilverlight/PF_NASA/Service/chart/load/PF _
NASA)enter Assign To name in the Search field > highlight name and identify
Supervisor.

Navigate to Outlook to identify the Assign To Supervisor email address and
populate the Escalation email



NSSC

Service Delivery Guide Number

NSSDG-9200-0012 Revision 4.0

Effective Date: May 14, 2021
Expiration Date: May 14, 2024

Page 28 of 69

Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

e)
f)
¢)]
h)

i)
)

Click Send

Make notes in the task and record work log

Copy notes to IRIS

Under IRIS Escalation Tasks section, check box next to the task/document

number

Drop down and select Close Selected

Access ServiceNow history and attach email, notes and center responses,

received via calls and emails, to each document in IRIS
Note: Each business day, BOT G. Washington logs into Microsoft Outlook
nssc-ap-invcescalation@mail.nasa.gov Archive folder at 7:00pm and
attaches all correspondences to each document in IRIS

3. Supervisor Phone Call Tab: Escalation actions are only required if a number is
present on the tab.

a)

b)
c)

d)

f)
9)
h)

i)
j)

If the Supervisor Phone Call tab lists activity, IE calls the Assign To
Supervisor to discuss list of aging documents using the Phone call template
listed in the Appendix section
|IE adds notes in the Work Notes section
IE will send a follow-up email using the HR organization charts
(https://orgpub.nssc.nasa.gov/OPSilverlight/PF_NASA/UI/PF_NASA.htm)
enter Assign To name in the Search field > highlight name and identify
Supervisor.
Navigate to Outlook to identify the Assign To Supervisor email address and
populate the Escalation email
Click Send
Make notes in the task and record work log
Copy notes to IRIS
Under IRIS Escalation Tasks section, check box next to the task/document
number
Drop down and select Close Selected
Access ServiceNow history and attach email, notes and center responses,
received via calls and emails, to each document in IRIS
Note: Each business day, BOT G. Washington logs into Microsoft Outlook
nssc-ap-invcescalation@mail.nasa.gov Archive folder at 7:00pm and
attaches all correspondences to each document in IRIS

4. Continuous Escalation Tab: Escalation actions are only required if a number is
present on the tab.

a)

b)
c)

If the Continuous Escalation tab lists activity, IE calls the Assign To Approver
first. If no contact is made with Assign to Approver then IE calls Supervisor to
discuss list of aging documents using the Phone call template listed in the
Appendix section

IE adds notes in the Work Notes section

IE will send a follow-up email using existing HR organization charts
(https://orgpub.nssc.nasa.gov/OPSilverlight/PF_NASA/Service/chart/load/PF_
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o O

@mm

NASA)enter Assign To name in the Search field > highlight name and identify
Supervisor.
d) Navigate to Outlook to identify the Assign To Supervisor email address and
populate the Escalation email
e) Click Send
f) Make notes in the task and record work log
g) Copy notes to IRIS
h) Under IRIS Escalation Tasks section, check box next to the task/document
number
i) Drop down and select Close Selected
j) Access ServiceNow history and attach email, notes and center responses,
received via calls and emails, to each document in IRIS
Note: Each business day, BOT G. Washington logs into Microsoft Outlook
nssc-ap-invcescalation@mail.nasa.gov Archive folder at 7:00pm and
attaches all correspondences to each document in IRIS
k) A document less than a NET 30 will be reviewed by the IE before taking the
proper escalation steps.

Goods Receipt Acceptance Escalation
IE will review Daily Agency Report for Unassigned GRAP documents and self-assign
IE will send initial email to end-user, CO, COTR, Buyer, logistics POC and attach email in
IRIS
Note: Each business day, BOT G. Washington logs into Microsoft Outlook nssc-ap-
invcescalation@mail.nasa.gov Archive folder at 7:00pm and attaches all
correspondences to each document in IRIS
1. Dirill into the PR on ME23N to view the text field for any additional POCs listed and
access the NASA data tab to identify the end user and invoice approvers
Note: To find the name of POC using the UUPIC (all numeric), go to id.nasa.gov >
People Search > Advanced > Enter number in UUPIC field and hit Search. To find
the name of POC using User ID (alpha and numeric), use SAP T-Code ZSUO1 and
enter number in User ID field.
2. If end user not found, use T-code SCASE and review e-file attachment or
Prism/Legacy to identify end user and/or invoice approvers
IE reviews GRAP documents daily to identify if 103/105 has been completed in SAP
1. View ME23N > Item Detail > Purchase Order History
If Committed Resolution Date (CRD) is provided, CRD will be updated in SNOW and
escalation will be suspended until CRD
If 103 is completed, IE will escalate to Logistics to complete the 105 or provide a CRD
If 103/105 is completed in SAP, IE will complete IRIS action request and post document

. 1f 103/105 is not completed 5 days prior to Adjusted Prompt Pay Due Date, IE will email the

end user, COTR, CO, the buyer and ACO if listed and CC the Center POC responsible for
posting the 103/105. Use email template for GRAP N:\FM Division\Accounts
Payable Accounts Receivable\Accounts Payable\Escalation Process\NSSC-Escalation
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Process 2018\EMAIL PDF\Communication Templates\Escalation Email Templates\Email
Templates
H. If 103/105 is not completed 3 days prior to the Adjusted Prompt Pay Due Date, IE will:
1. Call the end user
2. Send a follow up email using the email template for GRAP to the end user, CO
TR, CO, buyer, ACO, and 103/105 POC.
Note: If end user is civil servant, their supervisor will be CC’d using existing HR
organization charts
(https://orgpub.nssc.nasa.gov/OPSilverlight/PF_NASA/Service/chart/load/PF_NAS
A) enter COTR name in Search field > highlight name and identify Supervisor
[. 1f 103/105 is not completed 1 day prior to the Adjusted Prompt Pay Due Date and until the
invoice is posted, IE will:
1. Call the end user
2. Send a follow up email using the email template for GRAP to the end user, COTR,
CO, buyer, ACO, 103/105 POC, and Supervisor (if end user is civil servant).
NOTE: The “All Escalations Template” may be used to email all escalations to the
Assign To person when there are multiple escalations. Tasks will still need to be set to
“Close Selected” for each Document Number.
NOTE: Once all IRIS actions are complete (cost, funding GRAP, approval), VPP will
post invoice and process payment. Applicable escalations will continue until the invoice
is posted.
Note: Each business day, BOT G. Washington logs into Microsoft Outlook nssc-ap-
invcescalation@mail.nasa.gov Archive folder at 7:00pm and attaches all correspondences to
each document in IRIS
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PROCESS 3 — INVOICE ESCALATION CRITERIA

Contract/PO Approval Escalations

From the current date, documents that are 10 days or less before the Adjusted
Prompt Pay Due Date will be escalated as Day 10 email

From the current date, documents that are 5 days before the Adjusted Prompt Pay
Due Date will be escalated as Day 5 Phone Call and sent a follow-up email

From the current date, documents that are less than 1 day before the Adjusted
Prompt Pay Due Date will be escalated as Supervisor Phone Call and sent a follow-
up email

Documents that remain unposted will be updated to “Continuous Escalations” and
will be escalated daily via Supervisor Phone call and a follow-up email

Contract/PO Funding Escalation

From the current date, documents that are 21 days or less before the Adjusted
Prompt Pay Due Date will be escalated as Day 10 email

From the current date, documents that are 15 days before the Adjusted Prompt Pay
Due Date will be escalated as Day 15 Phone Call and sent a follow-up email

From the current date, documents that are 14 days before the Adjusted Prompt Pay
Due Date will be escalated as Day 14 Phone Call and sent a follow-up email

From the current date, documents that are less than 13 days before the Adjusted
Prompt Pay Due Date will be escalated as Phone Call and sent a follow-up email
including Supervisor

Documents that remain unposted will be updated to “Continuous Escalations” and
will be escalated daily via Supervisor Phone call and a follow-up email

Fl Approval Escalation

From the current date, documents that are 10 days or less before the Adjusted
Prompt Pay Due Date will be escalated as Day 10 email

From the current date, documents that are 5 days before the Adjusted Prompt Pay
Due Date will be escalated as Day 5 Supervisor Phone Call and sent a follow-up
email

From the current date, documents that are less than 5 days before the Adjusted
Prompt Pay Due Date will be escalated as Supervisor Phone Call and sent a follow-
up email
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Documents that remain unposted will be updated to “Continuous Escalations” and
will be escalated daily via Supervisor Phone call and a follow-up email

Fl Funding Escalation

From the current date, documents that are 15 days or less before the Adjusted
Prompt Pay Due Date will be escalated as Day 15 email

From the current date, documents that are 7 days before the Adjusted Prompt Pay
Due Date will be escalated as 7-day Phone Call and sent a follow-up email

From the current date, documents that are less than 7 days before the Adjusted
Prompt Pay Due Date will be escalated as Phone Call Continuous Escalations and
sent a follow-up email

Documents that remain unposted will be updated to “Continuous Escalations” and
will be escalated daily via Supervisor Phone call and a follow-up email

GRAP Escalation

From the current date, documents that are 5 days or less before the Adjusted
Prompt Pay Due Date will be escalated as Day 5 email to the end user, CO, COR,
ACO, and Buyer

From the current date, documents that are 3 days before the Adjusted Prompt Pay
Due Date and do not have the 103/105 posted will be escalated as Day 3 email
Phone Call to end user followed by email to end user, CO, COR, ACO, Buyer
Documents that remain unposted will be updated to “Continuous Escalations” and
will be escalated daily via calling the end user and sending a follow-up email to end
user, CO, COR, ACO, Buyer, and end user’s supervisor.

NOTE - the IE will e-mail the Center POCs when the end user states the items
have been received and are acceptable if the end user does not reply to all in the
email stating the items have been received and are acceptable.

NOTE - the IE will mark the GRAP IRIS request as complete after the 103/105 has
been posted.

Interest Fl Funding Escalation

e From the current date, documents that are 15 days or less before the Adjusted

Prompt Pay Due Date will be escalated as Day 15 email

e From the current date, documents that are 7 days before the Adjusted Prompt Pay

Due Date will be escalated as Day 7 email Supervisor Phone Call and sent a follow-
up email

e Documents that remain unposted will be updated to “Continuous Escalations” and

will be escalated daily via Supervisor Phone call and a follow-up email
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Unassigned Escalation Task

The IE Team will send an email to Center POCs for all unassigned tasks
requesting they go in IRIS and assign the pending actions, so the IE Team can
complete escalation.

Adjusted Prompt Pay Due Date

The Adjusted Prompt Pay Due Date takes into account the following:
¢ 3 days for posting the document once all actions are complete

1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)

Holidays and weekends



NSSC NSSDG-9200-0012 Revision 4.0

H H H Number
Service Delivery Guide Effective Date: May 14, 2021

Expiration Date: May 14, 2024

Page 34 of 69

Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

PROCESS 4 — AP ESCALATION CMP PERFORMANCE MEASURE REPORTS

6.2 CMP Performance Measure Report

A. On the 4" business day at 6:15am, BOT Adams uploads the Monthly 6.2 Aging report to
ServiceNow.

B. The following is the manual process:

On the 4™ business day at 6:15am, go to N:\FM Division\Accounts Payable Accounts
Receivable\CMP and click on the month year, CMP 6.2, and select the Monthly 6.2 Aging
report (most current version, titled “YYYY_MM_6.2_AGING”). Upload to ServiceNow > Invoice
Escalation>Load Data > CMP 6.2 Aging Report

1. 6.2 CMP Performance Measure identifies any posted document aged 30 days or older

a. Documents that are not escalated are excluded from review and will include the
following in the text field:

» CR

» Finals

» SBIR/STTR
» SD

2. Reviewable documents are compared to the escalation tasks performed on those
documents to determine whether escalation was performed properly or not and will
identify the performance measure as met or not met.

a. Met: SN Escalation task Closed date will be the same as the Created date. The
performance measure is met if 90% or more of the escalation tasks were closed
on the date the task was created.

b. Not Met: SN Escalation task Closed date is different than Created date. The
performance measure is not met if less than 90% of the escalation tasks were
not closed on the date the task was created.

3. Results of escalation performed on posted documents are displayed in ServiceNow >
Invoice Escalation > CMP > Performance Measure Reports > 6.2
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6.11 CMP Performance Measure Report

A. On the 4" business day at 6:15am, BOT Adams uploads the Monthly CMP 6.11 Exceptions
report to ServiceNow.

B. The following is the manual process:

On the 4" business day at 6:15am, upload the Monthly CMP 6.11 Exceptions report (titled
“CMP 6.11 Exceptions Report MM_YYYY”) from N:\FM Division\Accounts Payable Accounts
Receivable\Accounts Payable\Escalation\CMP Exceptions to ServiceNow > Invoice Escalation
> Load Data > CMP 6.11 Report

1. 6.11 CMP Performance Measure identifies any parked document aged 30 days or older

a. Documents that are not escalated are excluded from review and will include the
following in the text field:

» CR

» Finals

» SBIR/STTR
» SD

2. Reviewable documents are compared to the escalation tasks performed on those
documents to determine whether escalation was performed properly or not and will
identify those as met or not met.

a. Met: SN Escalation task Closed date will be the same as the Created date. The
performance measure is met if 90% or more of the escalation tasks were closed
on the date the task was created.

b. Not Met: SN Escalation task Closed date is different than Created. The
performance measure is not met if less than 90% of the escalation tasks were
not closed on the date the task was created.

3. Results of escalation performed on parked documents are displayed in ServiceNow >
Invoice Escalation > CMP > Performance Measure Reports > 6.11
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SYSTEM COMPONENTS (EXISTING SYSTEMS)

IT System Title

IT System Description

Access Requirements

IT System Interfaces

SAP/Integrated Integrated Financial User Role at NSSC SPS, bReady
Enterprise Management System

Management Program

(IEMP)

TechDoc/DlI System used for User Role at NSSC Accounts Payable

capturing invoice

Work Management

images System - AWMS
Invoice Routing System for routing and | User Role at NSSC SAP
Information System tracking invoices
(IRIS)
ServiceNow System for vendor, User Role at NSSC ServiceNow
customer inquiries,
NSSC internal
communication and
Invoice Escalation
Procurement for Public | Procurement Award User Role at NSSC SAP

Sector (PPS)

Application
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

CUSTOMER CONTACT CENTER STRATEGY

The NSSC Customer Contact Center can be reached via phone, fax or e-mail.
E-mail: nssc-contactcenter@nasa.gov

Fax: 1-866-779-6772

Phone: 1-877-NSSC123 (or 1-877-677-2123)

Document Imaging

All incoming documents will be received into the NSSC TechDoc Center, where they will be processed
and electronically filed. Documents may be sent to the NSSC as follows:

E-mail: NSSC-AccountsPayable@nasa.gov

Fax: 1-866-209-5415

Mail:

NASA Shared Services Center

Building 1111, Jerry Hlass Rd.

Stennis Space Center, MS 39529.

Relevant Points of Contact at the NSSC:

Financial Management Division — CS
Michele Rollins

NASA Shared Services Center
Building 1111 Jerry Hlass Rd.
Stennis Space Center, MS 39529
Phone: 228-813-6322

E-mail: Michele.M.Rollins@nasa.gov

Financial Management Division — SP
Sarita Harper

NASA Shared Service Center
Building 1111 Jerry Hlass Rd.
Stennis Space Center, MS 39529
Phone: 228-813-6913

E-mail: Sarita.Harper@nasa.gov
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX A — ACRONYM LIST

Acronym Definition

AAO Agency Applications Office

AP Accounts Payable

AWMS Accounts Payable Work Management System

CFO Chief Financial Officer

CLIN Contract Line Item Number

CS Civil Servant

DRN Document Reference Number

EPSS Enterprise Performance Support System

Fl Finance Invoice

FMD Financial Management Division

GRAP Goods Receipt and Approval

IPP Invoice Processing Platform

IRIS Invoice Routing and Information System

NASA National Aeronautics and Space Administration

NSSC NASA Shared Services Center

POC Point of Contact

PPS Procurement for Public Sector

SAP Systems, Applications, and Products

SBIR/STTR Small Business Innovation Research/Small Business
Technology Transfer

SNOW ServiceNow

SP Service Provider

T-Code Transaction Code

UUPIC Universal Uniform Personal Identification Code

VPP Vendor Payment Processor
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX B — AP INVOICE ESCALATION PROCESS WORKFLOW

FM- Accounts Payable Invoice Escalation Process Flow

Received Date (See
Note 1)

Escalation — Notify
Assign To by e

mail andfor phone
call of aging action

A 4

Add e-mail or
phone
communicaion
information in IRIS

(@]
o Receive Daily » scalation ) { Recsive Monthl )
% Agency Report hAN Cost Esca \_ Agency Fhﬁi:’*-""“‘I
= A
Action ages (See
Mote 2) — Process
o No > is epeated until
P Receive Daily Recsive Invoice action is complete
=0 Agency Report Es=calation
S < geney Notfication
(8] = A Yes
»~ l—P']' End Process |
Email Daily
Agency Reportsto
Upload to ServiceNow POCs
% | /Run IRIS Escalation pacuide Adusted
w rompt Pay Due date
@ Repartand SAP based on the Invoice
uz"r Invoice Stat Report

E-mail

=/M-mihry Performance

Management Report

NOTE 1: The Adjusted Prompt Pay Due Date takes into account the folowing:
- 3 days for posfing the document once all actions are complete
- 1 day for the IPP CLIN validation to run overnight

- 1 day for the payment proposal run

- Month-end closing for payments (the last 3 business days)

- Holidays and weekends

NOTE 2: Aging actions will be escalated to supervisor
NOTE 3: NSSC Civil Servants (CS) oversees the process
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Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

APPENDIX C — AGING INVOICES ESCALATION EMAIL

Dear (Approver):

Please find a list of document(s) below that are assigned to you in IRIS and are pending your action.
Completing the action(s) by the adjusted prompt payment due date listed will avoid interest penalties being
paid.

Approval Type  Activity Type BA  Center Doc Number ' Invoice Amount Invoice Received Date  Adjust Prompt Pay Due Date | PO Number 533Ind
Contract Approval - Email 22 ' Glenn Research Center 5603085118 ' 42160.86 2019-06-06 2019-06-24 B80GRC0O18C0034 : X

Contract Approval = Email 22 | Glenn Research Center 5603085119 @ 2951.23 2019-06-06 2019-06-24 B0GRCO18C0034 X

If your actions have dependencies (i.e. you are waiting for the Contractor’s 533 to be processed, you are
waiting for a report to be evaluated, the item is going through quality testing, etc.), please reply to this e-mail or
contact the NSSC Customer Contact Center so the dependency can be noted, and escalations temporarily
suspended.

For assistance completing IRIS requests, please refer to EPSS IRIS job aids (hyperlink added).

If you have questions or need further assistance, please contact the NSSC at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Please disregard this notification if you already completed this action and marked it complete in IRIS.

Note: The Adjusted Prompt Pay Due Date takes into account the following:
» 3 days for posting the document once all actions are complete
+ 1 day for the IPP CLIN validation to run overnight
» 1 day for the payment proposal run
* Month-end closing for payments (the last 3 business days)
* Holidays and weekends

Thank you,

The NSSC Accounts Payable Invoice Escalation Team
Web: http://www.nssc.nasa.gov/customerservice

Fax: 1-866-779-6772
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Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

APPENDIX D — DAILY AGENCY APPROVAL REPORT EMAIL TEMPLATE

Dear (Procurement):
Subject: Daily Agency Approval Report

Please find the attached Daily Agency Pending Invoice Approval Report as of Month XX, XXXX for
your review.

*Documents aged 8 days or less from the Adjusted Prompt Pay Due Date are highlighted in RED
*Documents aged 9-15 days before the Adjusted Prompt Pay Due Date are highlighted in YELLOW

All other documents should be worked timely to prevent them from falling into YELLOW or RED
status.

If you have any questions or need further assistance, please contact the NSSC at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Note: The Adjusted Prompt Pay Due Date takes into account the following:
« 3 days for posting the document once all actions are complete

1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)

Holidays and weekends

Thank you,
The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice
Fax: 1-866-779-6772
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Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

APPENDIX E — DAILY AGENCY CONTRACT_PO FUNDING REPORT EMAIL
TEMPLATE

Dear (Contract/PO Funding Team):
Subject: Daily Agency Contract/PO Funding Pending Report

Please find the attached Daily Agency Contract/PO Funding Report as of Month XX, XXXX for your
review.

*Documents aged 8 days or less from the Adjusted Prompt Pay Due Date are highlighted in RED
*Documents aged 9-15 days before the Adjusted Prompt Pay Due Date are highlighted in YELLOW

All other documents should be worked timely to prevent them from falling into YELLOW or RED
status.

¢ Additionally, the NASA Shared Service Center (NSSC) needs your assistance to ensure
“‘UNASSIGNED” documents are assigned in IRIS. All IRIS actions need to be assigned to
the appropriate individuals in IRIS in order for Accounts Payable to perform the escalation
process.

If you have any questions or need further assistance, please contact the NSSC at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Note: The Adjusted Prompt Pay Due Date takes into account the following:
» 3 days for posting the document once all actions are complete

1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)

Holidays and weekends

Thank you,
The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice
Fax: 1-866-779-6772
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX F — DAILY AGENCY COST REPORT EMAIL TEMPLATE

Dear Cost Process Champion Team:
Subject: Daily Agency Cost Report

Please find the attached Daily Agency Cost Escalation Report as of Month XX, XXXX for your review.

*Documents aged 8 days or less from the Adjusted Prompt Pay Due Date are highlighted in RED

*Documents aged 9-15 days before the Adjusted Prompt Pay Due Date are highlighted in YELLOW

All other documents should be worked timely to prevent them from falling into YELLOW or RED

status.

If you have any questions or need further assistance, please contact the NSSC at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Note: The Adjusted Prompt Pay Due Date takes into account the following:
3 days for posting the document once all actions are complete
1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)

Holidays and weekends

Thank you,

The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice

Fax: 1-866-779-6772
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Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

APPENDIX G — DAILY AGENCY FI APPROVAL REPORT EMAIL TEMPLATE

Dear (FI Invoice Approval Team):
Subject: Daily Agency FI Approval Report

Please find the attached Daily Agency FI Invoice Approval Escalation Report as of Month XX, XXXX
for your review.

*Documents aged 8 days or less from the Adjusted Prompt Pay Due Date are highlighted in RED
*Documents aged 9-15 days before the Adjusted Prompt Pay Due Date are highlighted in YELLOW

All other documents should be worked timely to prevent them from falling into YELLOW or RED
status.

Additionally, the NASA Shared Service Center (NSSC) needs your assistance to ensure
“‘UNASSIGNED” documents are assigned in IRIS. All IRIS actions need to be assigned to the
appropriate individuals in IRIS in order for Accounts Payable to perform the escalation process.
If you have any questions or need further assistance, please contact the NSSC at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Note: The Adjusted Prompt Pay Due Date takes into account the following:
+ 3 days for posting the document once all actions are complete

1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)

Holidays and weekends

Thank you,
The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice
Fax: 1-866-779-6772
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Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

APPENDIX H — DAILY AGENCY FI FUNDING REPORT EMAIL TEMPLATE

Dear (FI Funding Team):

Please find the attached Daily Agency FI Funding Escalation Report as of Month XX, XXXX for your
review.

*Documents aged 8 days or less from the Adjusted Prompt Pay Due Date are highlighted in RED
*Documents aged 9-15 days before the Adjusted Prompt Pay Due Date are highlighted in YELLOW

All other documents should be worked timely to prevent them from falling into YELLOW or RED
status.

Additionally, the NASA Shared Service Center (NSSC) needs your assistance to ensure
“‘UNASSIGNED” documents are assigned in IRIS. All IRIS actions need to be assigned to the
appropriate individuals in IRIS in order for Accounts Payable to perform the escalation process. If you
have any questions or need further assistance, please contact the NSSC at

1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Note: The Adjusted Prompt Pay Due Date takes into account the following:
3 days for posting the document once all actions are complete

1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)
Holidays and weekends

Thank you,
The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice
Fax: 1-866-779-6772
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Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

APPENDIX | — DAILY AGENCY GRAP REPORT EMAIL TEMPLATE

Dear (GRAP Team):

Please find the attached Daily Agency Goods Receipt/Acceptance Escalation Report as of Month XX,
XXXX for your review.

*Documents aged 8 days or less from the Adjusted Prompt Pay Due Date are highlighted in RED
*Documents aged 9-15 days before the Adjusted Prompt Pay Due Date are highlighted in YELLOW

Additionally, the NASA Shared Service Center (NSSC) needs your assistance to ensure
“‘UNASSIGNED” documents are assigned in IRIS. All IRIS actions need to be assigned to the
appropriate individuals in IRIS in order for Accounts Payable to perform the escalation process.
If you have any questions or need further assistance, please contact the NSSC at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Note: The Adjusted Prompt Pay Due Date takes into account the following:
+ 3 days for posting the document once all actions are complete

1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)

Holidays and weekends

Thank you,
The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice
Fax: 1-866-779-6772
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX J — DAILY AGENCY INTEREST FI FUNDING REPORT TEMPLATE

Dear (NSSC AP Lead):

Subject: Daily Agency Interest FI Funding Report

Please find the attached Daily Agency Interest FI Funding Escalation Report as of Month XX, XXXX

for your review.

Please ensure any “UNASSIGNED” actions are properly assigned to the appropriate individuals in

IRIS.

Note: The Adjusted Prompt Pay Due Date takes into account the following:
» 3 days for posting the document once all actions are complete

Thank you,

The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice

Fax: 1-866-779-6772

1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)
Holidays and weekends
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX K — SUPERVISOR ESCALATION EMAIL TEMPLATE

Dear (Supervisor):

Subject: ACTION REQUIRED: Please review IRIS Actions

Please find a list of documents below that are pending action in IRIS by (Assigned To). Pending
invoice actions need to be completed by the Adjusted Prompt Pay Due Date listed to avoid interest
penalties being paid to the vendors.

Approval Type

Activity Type

BA

Center

Doc Number

Invoice Amount

Invoice Received Date

Adjust Prompt Pay Due Date

PO Number

FI Approval

Continuous Escalation

51

Goddard Space Flight Center

1900068136

2915.86

2019-05-16

201%-06-10

As the applicable actions are performed, please ensure pending requests are marked as complete in
IRIS so the invoices can be posted and processed for payment by the NSSC.

IRIS can be accessed at: https://iris.nasa.gov/

If you have any questions or need further assistance, please contact the NSSC at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Note: The Adjusted Prompt Pay Due Date takes into account the following:
» 3 days for posting the document once all actions are complete

Thank you,
The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice
Fax: 1-866-779-6772

1 day for the IPP CLIN validation to run overnight
1 day for the payment proposal run
Month-end closing for payments (the last 3 business days)
Holidays and weekends
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX L — PHONE COMMUNICATION TEMPLATE

Good morning/afternoon (Mr. /Ms.):

My name is (IE Name). I'm with the NASA Shared Services Center calling about some aging invoices

that require your attention. Do you have a few minutes to discuss these actions?

Before the call:

» Have a list of all aging actions available for discussion.

 Inform the Assign To person of the (CRD) Committed Resolution Date process

» Be prepared to discuss the Adjusted Prompt Pay Due Date calculation

» Ask the person if they would like an email with a list of invoices
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX M — VOICE MESSAGE COMMUNICATION TEMPLATE

Good morning/afternoon (Mr. /Ms.):

My name is (IE Name). I'm with the NASA Shared Services Center calling about some aging invoices
that require your attention. Please contact the Invoice Escalation team at your earliest convenience at

877.677.2123.

| will send you a follow-up email listing the invoices that require your action.

Have good day.

Before the call:

+ Have a list of all aging actions available for discussion.
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX N — AGENCY SBIR/STTR REPORT TEMPLATE

NOTE: The Agency SBIR/STTR Report will be emailed to NSSC Procurement POC’s

Dear (Procurement):

Subject: Daily Agency SBIR/STTR Report

Please find the attached Agency SBIR/STTR Report for invoices pending approval in the

Invoice Routing and Information System (IRIS). Please ensure pending invoice actions are
completed prior to the Adjusted Prompt Pay Date. If you have any questions or need further
assistance, please contact the NSSC at

1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Note: The Adjusted Prompt Pay Due Date takes into account the following:

+ 3 days for posting the document once all actions are complete

Thank you,

1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)
Holidays and weekends

The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice

Fax: 1-866-779-6772
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX O — DAILY AGENCY POSTED EXCEPTION REPORT

Invoices in Posted status will be monitored to determine if the invoice is ready for payment by the

VPP.

The report will be scheduled to be emailed to the NSSC VPP Leads daily where they will status
documents on the list. The IE will review aging documents and work with the AP Supervisor for

assistance, if needed to resolve issues.

IE will contact the VPP/Lead to alert them of the aging posted document to determine if disbursement
can be processed prior to aging on CMP 6.2

Report criteria:

¢ Invoice Status is Posted

e 5 days or less before Adjusted Prompt Pay Due Date
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX P — DAILY AGENCY PARKED EXCEPTION REPORT

Invoices in Parked status with all IRIS actions completed or aging with no IRIS actions will be
monitored to determine if the invoice is ready for posting by the VPP. If VPP posting actions are
necessary, IE will contact VPP or center Lead to work the invoice prior to aging on CMP 6.11.

The report is emailed to IE the first business day of every week. |E will review aging documents to
validate the text fields reflect the current pending action. |E will contact NSSC VPP or center Lead to

make any necessary corrections. IE will work with the AP Supervisor for assistance, if needed to

resolve issues.

Report Criteria:

e Invoice Status is Parked

e 20 calendar days or less before Adjusted Prompt Pay Due Date
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Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

APPENDIX Q — CONTINUOUS ESCALATION EMAIL TEMPLATE

Dear (Supervisor):
Subject: ACTION REQUIRED: Please review IRIS Actions

The NSSC Invoice Escalation Team have made several attempts to contact (Assigned To) regarding
the pending IRIS actions shown below.

To avoid interest penalties being paid to the vendors, pending invoice actions need to be completed
by the Adjusted Prompt Pay Due Date listed below.

Document Number Task Type Est. Due Date Adjust Prompt Pay Due Date
5603053303 Contract/PO Funding = 2019-05-17 2019-05-13
5603053299 Contract/PO Funding = 2019-05-17 2019-05-13
5603053245 Contract/PO Funding 2019-05-17 2019-05-13

As the applicable actions are performed, please ensure pending requests are marked as complete in
IRIS so the invoices can be posted and processed for payment by the NSSC.

Please disregard this notification if this action is already completed and marked complete in
IRIS.

For assistance completing IRIS requests, please refer to EPSS [RIS job aids.

If you have any questions or need further assistance, please contact the NSSC at 1-877-677-2123 (1-
877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Note: The Adjusted Prompt Pay Due Date takes into account the following:

3 days for posting the document once all actions are complete
1 day for the IPP CLIN validation to run overnight

1 day for the payment proposal run

Month-end closing for payments (the last 3 business days)
Holidays and weekends

Thank you,
The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice
Fax: 1-866-779-6772
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Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

APPENDIX R — UNASSIGNED IRIS ACTIONS EMAIL TEMPLATE

Dear POCs,
Subject: ACTION REQUIRED: Please review Unassigned IRIS Actions

Please find the attached list of documents that are pending action in IRIS. Unfortunately, we are
unable to complete invoice escalation because the IRIS action is unassigned.

To ensure the invoice escalation process is worked timely and correctly, please go into IRIS and
assign the pending actions as soon as possible.

IRIS can be accessed at: https://iris.nasa.gov/

If you have any questions or need further assistance, please contact the NSSC at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Thank you,
The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice

Fax: 1-866-779-6772
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Responsible Office: Financial Management Division

Subject: Accounts Payable Invoice Escalation Process

APPENDIX S — DAILY AGENCY ESCALATION REPORTS ISSUE EMAIL

TEMPLATE

Dear POCs,

Subject: Daily Agency Escalation Reports Issue

The Accounts Payable Invoice Escalation Team is experiencing technical difficulties with the Daily
Agency Escalation Reports. As a result, the data contained in the reports may not reflect the most

up-to-date information. If you have completed the action already in IRIS, please disregard.

The Information Automation Services and IT Teams are working to resolve the problem as quickly as

possible.

If you have any questions or need further assistance, please contact the NSSC at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Thank you,

The NSSC Accounts Payable Escalation Team

Web: http://www.nssc.nasa.gov/customerservice

Fax: 1-866-779-6772
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Responsible Office: Financial Management Division
Subject: Accounts Payable Invoice Escalation Process

APPENDIX T — GRAP END USER EMAIL TEMPLATES

Template for: Accounts Payable Invoice Escalation — GRAP Initial Email
Dear (End User Name):
Subject: Receipt of Iltems (PO#)
The NSSC has a pending receipt for item(s) ordered on award number (PO Number) in the amount of
(dollar amount of invoice). The Document Reference Number is (DRN). The invoice is due in
(number of days to APPDD) days.
If you have received the items ordered under this award, please reply to all in this e-mail and provide

the date(s) the item(s) was received and accepted. If you have not received the item, please notify us
by replying to this e-mail.

Line#  Quantity Recd __ Quantity Accepted _ Date Rec’d: Date Accepted:
Line#  Quantity Recd __ Quantity Accepted _ Date Rec'd: Date Accepted:
Line#__ Quantity Recd ___ Quantity Accepted ___ Date Rec’d: Date Accepted:
Line#__ Quantity Recd ___ Quantity Accepted __ Date Rec’d: Date Accepted:
Line#__ Quantity Recd ___ Quantity Accepted __ Date Rec’d: Date Accepted:

If you have any questions, or need further assistance, please contact us at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Thank you,
NSSC Accounts Payable Invoice Escalation Team
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Template for: Accounts Payable Invoice Escalation — GRAP Invoice Escalation Email Notification
TO: Dear (End User Name)

CC: Logistics POC

Subject: GRAP Noaotification

The NSSC has received invoice/document reference number that is pending goods receipt for award
order number (PO number) in the amount of (dollar amount). The goods receipt invoice is due in
(number of days until APPDD). If you have received the items ordered under this award, please reply
to all in this e-mail and include the receipt and acceptance date

Line # Quantity Rec'd Quantity Accepted Date Rec’d: Date Accepted:

Line # Quantity Rec’'d Quantity Accepted Date Rec’d: Date Accepted:

If you have any questions, or need further assistance, please contact us at
1-877-677-2123 (1-877-NSSC123) or by email at nssc-contactcenter@nasa.gov

Thank you,

NSSC Accounts Payable Invoice Escalation Team
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APPENDIX U — REVIEWING EXCEPTION REPORTS

INTEREST FI FUNDING REPORT

e The Daily Agency Interest FI Funding Exception Report is created and scheduled daily in
ServiceNow. The report is disseminated daily to NSSC internal POCs.
e The criteria for the Interest FI Funding Exception Report uses the following criteria

All of these conditions must be met

Active v is v true v AND OR b 4
Interest FI Funding Assigned to v is not empty v AND OR x

Doc Type v is not W Zl AND CR b4

Doc Type v is not v ZC AND CR x

Doc Type v is not W ZH AND CR X

Doc Type v is not W ZL AND OR X

Doc Number v is v javascript: new x_nas10_ap_ AND OR X

o Review the Daily Agency Interest FI Funding Report documents
o The IE will Log into SAP
o Enter T-Code ZFI_AP_CONSOLE in the search box

R e e [RRT P p LRy

1 [ZFI_AP_CONSOLE[EES

o Enter document number (5600#) in the Invoice Document No. field

Invoice
Invoice Document No. |5603169063 [ﬁ'jz 020 | Parked

IRIS Request Console
[ View Tab Screen

o Review IRIS notes and attachments

o Has the Lead escalated the document?
= If Yes, recently? Any updates in notes
= |f No, Email Lead
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¢ |E will update the spreadsheet with notes, actions taken, save in the appropriate month located
N:\FM __ Division\Accounts

Payable Accounts

Receivable\Accounts

Payable\Escalation

Process\NSSC-Escalation Process 2018\Exception Reports\Snow Reports FY20 and emails

NSSC POCs when completed.

PARKED REPORT

e The Daily Agency Parked Exception Report is created and scheduled weekly in ServiceNow.

The report is disseminated weekly to NSSC internal POCs.
e The criteria for the Parked Exception Report uses the following criteria
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All of these conditions must be met

StatusID

Active

Approval

or| Approval

Funding

or| Funding

GR

or| GR

Cost

or| Cost

Type

Type

Type

Type

Type

Type

v

is empty

is empty

is empty

is empty

is not

is not

is not

is not

is not

is not

o The IE will Log into SAP
o Enter T-Code ZFI_AP_CONSOLE in the search box

R e e (R P LR

&

—run

FIAP_CONSOLE

=}

Parked

true i

Approved

b4 X

Complete

e X

Complete

¥ X

Complete

W X

AND

AND

AND

AND

AND

OR

CR

OR

OR

OR

AND

AND

AND

AND

AND

AND

AND

o Enter document number (5600#) in the Invoice Document No. field

Invoice

Invoice Document No.

15603169063 [#p020| Parked

OR b %
OR X
OR X
OR b e
OR x
OR X
OR X
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o Select View Tab Screen or F8

IRIS Request Console

9 View Tab Screen

o The IE will review the following items of the report

Documents parked over 72 hours and not routed for any action

Penny documents that have posted/paid parent document

Text fields coincide with the current pending action following the Text Code

o NSSC Center AP Lead will be sent an email of document(s) to review for resolution
IE will update the spreadsheet with notes, actions taken, save in the appropriate month located
N:\FM _ Division\Accounts

Explanation

Completed actions waiting to be posted

Has it been 72 hours since action completed in IRIS

Payable Accounts

Receivable\Accounts

Payable\Escalation

Process\NSSC-Escalation Process 2018\Exception Reports\Snow Reports FY20 and emails

NSSC POCs when completed.

The Daily Agency Posted Exception Report is created and scheduled daily in ServiceNow.
The report is disseminated daily to NSSC internal POCs.

The criteria for the Posted Exception Report uses the following criteria

All of these conditions must be met

StatuslD

Active

Days remaining

Posting Date

Type

Type

Type

Type

Type

v 5]

v Is

v less than or is
v before

v is not

v is not

v is not

v is not

v is not

Posted

true

Yesterday

ZH

ZL

IT

Zc

Zl

AND

AND

AND

AND

AND

AND

AND

OrR || X

AND
OR | | X
OR | | X
OR | | X
OrR | | X
OrR | | X

OR | X

OR

AND

OR
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e The report is sent in excel format. The IE will verify Posting Date does not include the
last/prior business day.
o Example: Friday November 15 postings are not included on Monday November 18
report. Filter out last/prior business date from excel
o Sort the excel by BA
o Sort PPA Date “oldest to newest”
= Review documents with PPA date 6 business days from current date

Example: Current date is 11-11-2019; Any PPA date after 11-18-2019 will not be
reviewed. Any PPA date prior to 11-19-2019 will be reviewed

BA Type StatuslD  Document tNo OA/Contract Numbei Purch Do~ Amount  Invoice Received Date  PPA Date  Adjusted Prompt Pay Due Date Due liately IRISURL  Posting Date
76 RE Posted 5603130946_2019 "8500024481 9,283.82 2019-08-22 2019-10-10 2019-09-16 https://iris.  2019-09-13
nasa.gov/ir
is.ui/invoic
e.jsp?invoi
celd=5603
130946201

23 KR Posted 1900007493_2020 37.16 2019-10-11 2019-11-12 2019-11-04 https://iris.  2019-11-13

e.jsp?invoi
celd=1900
007493202
0

e Loginto SAP
e Enter T-Code MIR4 in the search box
&% MIR4 3|

Enter document number (DRN) to review from Daily Agency Posted Report

Display Invoice Document
|6%° Display Document ‘

Invoice Document No. 5603154806

Fiscal Year 2020
J Enter Display Document

S Display Document

Review any attachments or notes on the document that explain what the document is pending
Select Follow-On Documents

Follow-On Documents ...

Double click 5600# - Accounting Document
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Documents in Accounting

Document |Object type text
5603154806 Accounting document

e Scroll if necessary to bottom and double click the vendor name and ZREM.

Doc.Type : RE ( Invoice - gross ) Normal document

Parked by NsS000442 Posted by NS000580

Doc. Number 5603154806 Company Code NASE Fiscal Year

Doc. Date 09/11/2019 Posting Date 11/07/2019 Period

Calculate Tax [

Ref.Doc. 80NSSC18P2157 8

Doc. Currency USD

Doc. Hdr Text IPP Standard Invoice

Itm|PE|Account Account short text AZmount | Funds Center
1(86(21%0.1000|0ther Liab Str Line 9,660.17 |10
2(86(219%0.1000|0ther Liab Str Line 5,325.47 (10
3(86(219%0.1000|0ther Liab Str Line 5,325.47 (10
4(86(21%0.1000|0ther Liab Str Line 5,325.47 (10
5(86(21%0.1000|0ther Liab Str Line 5,325.47 (10
6|86|21590.1000|0ther Liab Str Line 5,325.48 (10
7(86(21%0.1000|0ther Liab Str Line 5,325.47 (10
8|31(155958 PLASMA PROCESSES, LL 41,613.00-

= 0.00

e On the next screen if there is a clearing date and 2000# the date identifies when the document

was placed on a proposal.

Drill into the 2000# provides a 1300# which is the date/clearing

number treasury accepted the payment

11;05;2019|f|2009921313i

Clearing
o If there is not a clearing date or 2000#, the document is still not processed on a

proposal; review the text field on the follow on (under the clearing date field) for any
valid reasons pending the invoice being processed on a proposal

o Valid reasons would include: EFT Cancellation, ZREM Update, Foreign Payment
Text |E|-—I' Cancelation FMC029504/FMT58737
Text |CFE]11 Pending Payment Acknowledgement
Text |Pending ZREM Update FMC048485/FMT058477

Another reason could be the lead attempted to process the payment but another
proposal for another center had the ZREM blocked. The ZREM can only be paid on
one proposal. Once the payment has been processed by the civil servant, the ZREM is
free to be placed on another payment proposal.
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o Payment Proposals are automated. The results are found on the N drive every morning

for the leads to review and validate.

N:\FM Division\Accounts Payable Accounts Receivable\Accounts Payable\Payment

Proposals\FY 2020

Select the correct month

Select the center to review document

Select the current date spreadsheet

Review proposal exception tabs

Messages provide ZREMS that were unable to be processed for the center. The ZREM

is noted to be contained in another proposal and identifies what other proposal had the
ZREM for payment

© O O O O

Time Message text uncoded |
06:06:58 Vendor 152643 NASA is contained in proposal 11/18/2019 5D031; no editing |

06:06:58 Vendor 152643 NASA is contained in proposal 11/18/2019 5D031; no editing |

06:07:40 Vendor 157666 NASA is contained in proposal 11/18/2019 HD034; no editing |

06:07:40 Vendor 157666 NASA is contained in proposal 11/18/2019 HD034; no editing |

| Raw Data | MD044 | MD044 Exceptions | (3

¢ |E will update the spreadsheet with notes, actions taken, save in the appropriate month located
N:\FM _ Division\Accounts Payable Accounts Receivable\Accounts Payable\Escalation
Process\NSSC-Escalation Process 2018\Exception Reports\Snow Reports FY20 and emails
NSSC POCs when completed.

SD REPORT

e The Daily Agency SD Exception Report is created and scheduled weekly in ServiceNow. The
report is disseminated weekly to NSSC internal POCs.
e The SD Exception Report uses the following criteria:
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All of these conditions must be met

Text v contains v sD AND OR X
Days remaining v less than oris v 20 AND OR *
Active v is v true v AND OR X
Type v is not hd 71 AND OR x
Type v is not v zC AND || OR x
Type v is not v ZH AND OR X
Type v is not v 7L AND || OR X

Once an IE receives the report, they are to review the document(s) on the report for the
following:

o Loginto SAP

o Enter T-Code ZFI_AP_CONSOLE in the search box

R e e (R P p LRy

1 [ZFI_AP_CONSOLE[EES

o Enter document number (5600#) in the Invoice Document No. field

Invoice
Invoice Document No. ‘5603169063 [ﬁ’jz 020 | Parked

o Select View Tab Screen or F8
IRIS Request Console
[ View Tab Screen

o Review
= |If document is related to IPAC, exclude from review
= Has the document been routed and is pending IRIS actions?

e If Yes — email the Lead of the document number and in the email provide
a reminder that SD is only used in the text when a document is unable to
be routed.

e |If No — review notes on the document and if a SNOW ticket is notated,
review any updates to the notes. If the notes in the ticket or on the
document have not been updated in two days, email the lead or vendor
master (if pending action) for an updated status
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¢ |E will update the spreadsheet with notes, actions taken, save in the appropriate month located
N:\FM Division\Accounts Payable Accounts Receivable\Accounts Payable\Escalation
Process\NSSC-Escalation Process 2018\Exception Reports\Snow Reports FY20 and emails
NSSC POCs when completed.

AGING OUTSTANDING LATE INVOICE REPORT

e The Aging Outstanding Late Invoice Report is created and scheduled weekly in ServiceNow.
The report is disseminated weekly to NSSC internal POCs.

e The criteria for the Aging Outstanding Late Invoice Report use the following:

All of these conditions must be met

Active v is ~ | frue ~ AND | OR | | X
Doc Type v is not ~| AND || OR | | X
Doc Type v is not ~ | IC AND | OR x
Doc Type v is not ~ | ZH AND | OR x
Doc Type v is not v | ZIL AND || OR x
Doc Number v is v | javascript: new x_nas10_ap AND || OR X
or  Doc Number v is || javascript: new x_nasl0_ap X
or Doc Number v is || javascript: new x_nas10_ap X
or | Doc Number v is v | Javascript: new x_nasl0_ap X
or | Doc Number v is | Javascript: new x_nasl0_ap X
or | Doc Number v is | javascript: new x_nasl0_ap X
or Doc Number v is ~ | javascript: new x_nasl0_ap X
Est. Due Date v before ~ | This month ~ AND | OR | | X

e Once SP AP Supervisor or delegate receives the report, they are to review the document(s) on
the report for the following:

o Review escalation performed for each document on the report to ensure escalation is
being performed accurately.
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=  Enter Document number in ServiceNow >Invoice Escalation > IRIS Escalation
Tasks and filter by false in the Active field





